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Disclaimer and Shareware License Agreement
Before you use Personal Stock Monitor (the “Software”) for the first time, please read this 
Disclaimer and License Agreement.    By your action of using Personal Stock Monitor, you are 
agreeing to comply with all terms contained in this License.

Users of Personal Stock Monitor must accept this disclaimer of warranty: "The Software is 
supplied as is.    Anatoly Ivasyuk (the “Author”) disclaims all warranties, expressed or 
implied, including, without limitation, the warranties of merchantability and of fitness for any
purpose.    The Author assumes no liability for damages, direct or consequential, which may 
result from the use of the Software."

Personal Stock Monitor is a "shareware program" and is provided at no charge to the user for
evaluation for a period of 30 days.    After the 30-day evaluation    you must make a 
registration payment of $25 to the Author (see the Registration section for details).    The 
registration fee will license one copy of the Software to the user for use on any one 
computer at any one time.    When you register, you will receive a key which will disable the 
reminder screen and the “UNREGISTERED SHAREWARE” notice on printouts.    When the 
Software has been registered, it is no longer considered shareware and may not 
be freely distributed.    Site-License arrangements may be made by contacting the Author.

All content accessed through the Software is the property of the applicable content owner 
and may be protected by applicable copyright law.    This License gives you no rights to such 
content.

Individuals may freely distribute only unaltered copies of the archive containing the Software
and all associated files to your friends for evaluation. Organizations who wish to include this 
program in "shareware" distributions for remuneration must contact the Author for explicit 
authorization.

The Title, ownership rights, and intellectual property rights in and to the Software shall 
remain with the Author.    You agree to abide by the copyright law and all other applicable 
laws of the United States including, but not limited to, export control laws.    You 
acknowledge that the Software in source code form remains a confidential trade secret of 
the Author therefore you agree not to modify the Software or attempt to decipher, 
decompile, disassemble or reverse engineer the Software, except to the extent applicable 
laws specifically prohibit such restriction.



Registering Personal Stock Monitor
Registration requires that you send your full name and address, and in return you will 
receive a registration key through email.    You can then enter your full name in the User 
Name box and the registration key in the Registration Key box, and press the “Register” 
button.    Successful registration will get rid of the nag screens and the “Unregistered” 
messages on printouts.    The registration fee for this version of PSM is US$25, and I can only 
accept checks and money orders at this time.    Payment must be in US dollars, or you can 
send international postal money orders in US dollars.    To print this order form, click on Print 
Topic in the File pull-down menu.    Please make sure all information on the registration form 
is legible and correct, especially your full name and email address.

Mail the registration form, along with your payment, to:
Anatoly Ivasyuk
PO Box 1057
Germantown, MD 20875-1057
USA

Date _______________
Full Name ______________________________________________

Email
Address

______________________________________________

Company ______________________________________________
Address ______________________________________________
Address ______________________________________________
Address ______________________________________________

Day Phone _____________ Evening 
Phone

_____________

____ Copies x US$25 
=

$____________

Comments:



About Personal Stock Monitor
Personal Stock Monitor (PSM) is an application which automatically retrieves equities prices 
from free quote servers and displays them in a convenient manner on your desktop.    PSM 
can automatically alert you when an equity reaches a high or low target price.    In upcoming 
versions, PSM will help you keep track of your shares and will automatically recalculate your 
portfolio value as stock prices are updated.

Major Features
 Track an unlimited number of equities.
 Basic portfolio management.
 Export capabilities.
 Use one of several free quote servers on the Internet.
 Use multiple simultaneous connections for increased speed.
 HTTP proxy support.
 Configurable column view.
 Configurable update interval.
 High and low price alerts, with several alert types.

PLEASE NOTE THAT ALL STOCK PRICES DISPLAYED BY THE SOFTWARE ARE DELAYED BY AT 
LEAST 15 MINUTES DUE TO REGULATIONS IMPOSED BY THE EXCHANGES ON THE QUOTE 
SERVERS.    THE SOFTWARE DOES NOT SUPPORT RETRIEVING DATA FROM THE FEE-BASED 
SERVERS.
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System Requirements
PSM will run under the following operationg systems:
 Windows 95
 Windows NT 3.51 or later
 Windows 3.1x and Windows for Workgroups with Win32s 1.30 or later.

The minimum memory required is 4 MB, but 8MB is strongly recommended, especially when 
running with Win32s.

A 32-bit winsock is required for Windows 95 and Windows NT.    The few of you who are still 
running 16-bit versions of Trumpet Winsock on Windows 95, for example, will need to 
upgrade to the 32-bit version.    Win32s does not require a 32-bit winsock because it does 
something called “thunking”, which translates 32-bit winsock calls to 16-bit.

The version of Win32s may be checked by reading the win32s.ini file in your    WINDOWS or 
WINDOW\SYSTEM directory.    If you do not have Win32s 1.30, it may be obtained from the 
Microsoft Web site:

http://www.microsoft.com/kb/softlib/mslfiles/pw1118.exe



Getting Started
Personal Stock Monitor starts for the first time with some defaults which I consider to be 
appropriate for the first-time user:
 Use PC Quote as the default quote server.
 Update stock prices every 15 minutes.
 Use a maximum of one connection at a time.
 Terminate a connection after 60 seconds of inactivity.

You can change these defaults in the General Preferences.

The status bar at the bottom of the window will notify you of progress during quote retrieval. 
If PSM is not able to retrieve a stock quote for any reason, a message to that effect will be 
displayed in the status bar.

Stock symbol operations are under the Symbol menu and under a context menu in the 
symbol view.    You can add your favorite stock symbols by selecting the new symbol option, 
then let PSM do the rest of the work...

Please note that PSM starts up in “online” mode, which means that it will try to go out over 
the Internet and update symbol prices as soon as you enter them.    This may cause your 
machine to hang if you are not connected to the Internet at the time.    The solution is to 
start PSM without any symbols, then go to the Network Preferences and turn off automatic 
updates.    When you are connected to the Internet, you can turn automatic updates back on,
and PSM will update the symbol prices.



Choosing a Quote Server
Although the quote server you use is largely a matter of choice if you only need the basic 
features, the servers are actually quite different.    If you need direct support for a specific 
feature, you may need to choose a specific server.

Please note that for servers which do not support Previous Close or % Change, they are 
calculated as follows:

Previous Close = Current Price - $ Change
% Change = $ Change / Previous Close

The specific fields and features supported by each of the servers is shown in the following 
table:

PC Quote SecAPL CNNfn DBC StockCent
er

Symbol Name X X X X
Current Price X X X X X
$ Change X X X X X
% Change calculated X calculate

d
X calculated

Open X X X
Open Interest X
Day High/Low X X X X X
Previous Close X calculate

d
X X calculated

52 Week 
High/Low

X X X X

Volume X X X X X
Bid X X X X
Ask X X X X

Multiple 
Queries*

+ X

Canadian Stocks X X
Mutual Funds X X X X X
Commodities X X

* - Multiple queries per connection feature is currently not supported by PSM.
+ - Server supports this feature, but not in a format that PSM can use.



How to find stock and commodity symbols
PSM does not currently support ticker symbol lookups, so if you do not know the symbol for a
particular company, you need to directly ask the quote server.    Each of the servers used by 
PSM have some kind of symbol guide, so that will be the final authority on which symbols 
you can retrieve.

Please note that not all quote servers list support all possible symbols.    PC Quote and 
Security APL servers seem to support more symbols than the others, so that should be the 
first place to look.

How to retrive Canadian quotations
It seems that although some of the quote servers support getting Canadian stock quotes, 
the method is not quite obvious.    First of all, each server has a different syntax for Canadian
symbols.    In general, it seems that you can specify a Canadian symbol in this format:

e.sss
Where e is the letter of the exchange, and sss is the symbol.    The letters for the exchanges 
are:

T - Toronto
V - Vancouver
C - Alberta
M - Montreal

For example, V.IPS is Integrated Paving Concepts on the Vancouver Stock Exchange (VSE).

Please note that these servers do not necessarily maintain a complete list of all Canadian 
stocks, in which case PSM will return an ‘Unable to get value of symbol' error.

How to retrieve futures and indexes quotations
Some of the quote servers support retrieving quotations futures and indexes.    The rules 
seem to be a bit different for each server, so you need to check for specifics.    You can go to 
one of the quote server addresses below in order to find rules for futures, indexes, Canadian 
stocks, and any other symbol types supported by the server.

Quote Server Address (URL)
PC Quote http://www.pcquote.com
Security APL http://www.secapl.com
DBC http://www3.dbc.com
CNNfn http://www.cnnfn.com
StockCenter http://www.stockcenter.com



Building a portfolio
Personal Stock Monitor has some very basic portfolio management features, which will be 
enhanced in future versions.    You can currently store the number of shares, purchase price, 
and purchase date of those shares, and PSM will automatically calculate the net gain/loss 
based on the current price.

To add shares to your portfolio, select the symbol from the list, and select the Add to 
Portfolio command from the Symbol menu.    The information you enter will be added to your
portfolio, and a TOTAL line will be added to the bottom of the symbol view.    Initially you will 
not see any information in the list view, because the portfolio columns are not visible by 
default.    You should go to the View Properties dialog and make sure that the portfolio 
columns you want to see are visible.

You can view your holdings for a particular symbol through the Portfolio page of the Symbol 
Properties dialog.    All changes in this page
will be reflected in the main list view after you press the OK button.



File menu commands

New command ( , CTRL +N)
Use this command to create a new document in Personal Stock Monitor.

Open command ( , CTRL+O)
Use this command to open an existing document in a new window.

Save command ( , CTRL+S)
Use this command to save the active document to its current name and directory.    When
you save a document for the first time, Personal Stock Monitor displays the Save As 
dialog box so you can name your document.    If you want to change the name and 
directory of an existing document before you save it, choose the Save As command.

Save As command
Use this command to save and name the active document.    Personal Stock Monitor 
displays the Save As dialog box so you can name your document.    To save a document 
with its existing name and directory, use the Save command.

Export command
Use this command to export the current data to a text file.    Personal Stock Monitor 
displays the Export dialog box so you can select the type of file you wish to create.

Preferences command
Use this command to bring up the Preferences dialog box.

Print command ( , CTRL+P)
Use this command to print a document.      This command presents a Print dialog box, 
where you may specify the range of pages to be printed, the number of copies, the 
destination printer, and other printer setup options.

Print Preview command
Use this command to display the active document as it would appear when printed.    
When you choose this command, the main window will be replaced with a print preview 
window in which one or two pages will be displayed in their printed format.    The print 
preview toolbar offers you options to view either one or two pages at a time; move back 
and forth through the document; zoom in and out of pages; and initiate a print job.

Print Setup command
Use this command to select a printer and a printer connection.    This command presents 
a Print Setup dialog box, where you specify the printer and its connection.

1, 2, 3, 4 command
Use the numbers and filenames listed at the bottom of the File menu to open the last 
four documents you closed.    Choose the number that corresponds with the document 
you want to open.

Exit command (ALT+F4)
Use this command to end your Personal Stock Monitor session.    You can also use the 
Close command on the application Control menu.    Personal Stock Monitor prompts you 
to save documents with unsaved changes.





Edit menu commands
Undo    command (CTRL+Z)

Use this command to reverse the last editing action, if possible.    This command is 
currently not supported by PSM.

Cut command ( , CTRL+X)
Use this command to remove the currently selected data from the document and put it 
on the clipboard.    This command is unavailable if there is no data currently selected.    
Cutting data to the clipboard replaces the contents previously stored there.

Copy command ( , CTRL+C)
Use this command to copy selected data onto the clipboard.    This command is 
unavailable if there is no data currently selected.    Copying data to the clipboard replaces
the contents previously stored there.

Paste command ( , CTRL+V)
Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.



Symbol menu commands
New command

Use this command to insert a new symbol into the document.    The symbol will be added 
to the view, at which point you can edit the actual symbol name directly in the view.

Delete command
Use this command to delete the currently selected symbol(s) in the view.    If delete 
confirmation is set, a confirmation dialog will be displayed before the symbol(s) are 
deleted.

Update Selected command
Use this command to update the currently selected symbol(s) in the view.

Update All command ( )
Use this command to update all symbols in the document.

Clear Alert command (Alt+A)
Use this command to clear any alerts on currently selected symbol(s) in the view.

Clear All Alerts command
Use this command to clear alerts on all symbol in the document.

Add to Portfolio command
Use this command to add a portfolio entry for the selected symbol.    This command is 
disables if more than one symbol is selected.

Properties command (Alt+Enter)
Use this command to display the symbol properties dialog for the selected symbol.    This 
command is disabled if more than one symbol is selected.



View menu commands
Toolbar command

Use this command to display and hide the Toolbar, which includes buttons for some of 
the most common commands in Personal Stock Monitor, such as File Open.    A check 
mark appears next to the menu item when the Toolbar is displayed.    See Toolbar for help
on using the toolbar.

Status Bar command
Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch 
state. A check mark appears next to the menu item when the Status Bar is displayed. 
See Status Bar for help on using the status bar.

Split command (experimental)
Use this command to split the view vertically.    PSM will allow you to position the splitter 
bar, and will create a copy of the current view.    Each view can then be scrolled and 
configured independently.

Properties command
Use this command to bring up the View Properties dialog, where you can configure 
visible columns.

Always on top command
Use this command to toggle the “always on top” status of the application window.    When
this flag is enabled, a check mark appears next to the menu item, and the PSM 
application window will remain on top of other windows on the desktop which do not 
have this flag set.



Help menu commands
Index command

Use this command to display the opening screen of Help.    From the opening screen, you 
can jump to step-by-step instructions for using Personal Stock Monitor and various types 
of reference information.    Once you open Help, you can click the Contents button 
whenever you want to return to the opening screen.

About command
Use this command to display the registration screen, which also shows the copyright 
notice and version number of your copy of Personal Stock Monitor.



File Open dialog box
The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

Drives
Select the drive in which Personal Stock Monitor stores the file that you want to open. 

Directories
Select the directory in which Personal Stock Monitor stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Personal Stock 
Monitor adds the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Export dialog box
The following options allow you to specify the data to export and the type of file you wish to 
create:

All Symbols
Check this option to write the data for all symbols in the current document to the export 
file.

Selected Symbols
Check this option to write the data only for symbols you have selected from the symbol 
list.    If you have not selected any symbols, this option is disabled.

Comma-separated text file
Check this option to generate a text file in which the fields will be separated by commas. 
This option is useful for importing the resulting into spreadsheets.

Tab-separated text file
Check this option to generate a text file in which the fields will be separated by tab 
characters.    Some applications that you may want to use the data with may support this
format instead of the comma-separated format.

Quicken-compatible text file
Check this option to generate a text file which Quicken will accept as an update file.

Export...
When you have selected the symbols and file type you want, click on this button in order 
to bring up a dialog which will let you enter the name of the export file.



General preferences
Display numbers as fractions

Checking this option will cause PSM to display numbers in their fractional form when it is 
appropriate to do so.    If a number is not divisible by 1/64th, it is left as a decimal.    Also, 
this option does not affect percentages, which always displayed as decimals.

Display numbers as decimals
Checking this option will cause PSM to display all numbers in their decimal form.    This 
option does not affect percentages, which are always displayed as decimals with two 
digits to the right of the decimal point.

Precision
When numbers are displayed as decimals, this field specifies how many digits will 
appear to the right of the decimal point.    Numbers will be rounded when necessary.

Ask before deleting symbol
Checking this option will bring up a confirmation dialog whenever you want to delete a 
symbol from the document.

Ask before renaming symbol
Checking this option will bring up a confirmation dialog whenever you want to change 
the name of an existing symbol.

See also
Alert preferences
Network preferences
Proxy preferences



Alert preferences
No alerts

Checking this option will disable all alerts.

Flash window
Checking this option will flash the title bar of the application window if the application is 
minimized when an alert occurs.

Bring window on top
Checking this option will bring the application window to the top of the window stack if it 
is obscured by another window, and will restore it if it is minimized.

Beep
Checking this option will cause Personal Stock Monitor to generate a system beep when 
an alert occurs.    You can set the repeat frequency of the beeps using the settings below.

Play .WAV file
Checking this option will cause Personal Stock Monitor to play a .WAV file when an alert 
occurs.    You should use this option only if you have a sound card or speaker driver 
capable of playing .WAV files.    You can set the repeat frequency using the settings 
below.

Once
Checking this option will generate only one alert indication when an alert occurs.

Repeat every n seconds
Checking this option will generate an alert indication at the specified interval for as long 
as there are active alerts.    Use the Clear Alert or Clear All Alerts options to clear the 
active alerts.

See also
General preferences
Network preferencesProxy preferences



Network preferences
Preferred quote server

Select one of the default servers as the one to query for symbol prices.

Max. server connections
Set the maximum number of simultaneous connections to use for updating stock prices.   
Since Personal Stock Monitor currently can only query one symbol per connection, and if 
you have a reasonably fast Internet connection, increasing the number of server 
connections will increase the speed at which update can occur.

Drop connection after n seconds
Set the maximum number of seconds of inactivity which can occur before a connection is
terminated.    This setting prevents symbol updates from hanging the application, and 
allows Personal Stock Monitor to retry the update a bit later.

Enable automatic updates
Use this command to enable timed updates of symbols in the document.    If automatic 
updates have been enabled, symbols are automatically updated at the interval specified.

Update stock prices every n minutes
Set the frequency at which symbol prices will be updated.    This setting is used only if 
automatic updates are enabled.    Each symbol is updated independently, so the update 
period for a particular symbol will be reset if you choose to update it manually.    The next
symbol to be updated is always listed in the Status Bar.

See also
General preferences
Alert preferencesProxy preferences



Proxy preferences
User Proxy Host

If this box is checked, the HTTP proxy configuration will be used as the active 
configuration.    If your organization uses an HTTP proxy host and you have filled in the 
host and port fields, you need to check this box.

Proxy host
Set the host name which is used as the HTTP proxy.    Some organizations use a HTTP 
proxy host for one reason or another, so ask your system administrator if you need to 
use this field.    If you are not sure about what to put in this field, you should probably 
leave it blank.

Proxy port
Set the port used at the HTTP proxy.    If you set the Proxy host, you need to make sure 
that the port number entered in this field is correct for your location.    In many cases, 
using the default port 80 is fine, but check with your system administrator if you are not 
sure.

User Name
Some HTTP proxy servers require the user to authenticate himself.    If this is the case 
with your server, you need to fill in this field with the appropriate user name.

Password
If you filled in a user name, you need to fill in this field as well as part of the 
authentication procedure.    If you do not have the Save Password box checked, it will 
only be used for the duration of the current session.

Save Password
Check this box if you want the password to be saved as the default so that you do not 
have to type it again.

See also
General preferences
Network preferences
Alert preferences



Symbol General Properties
This property page shows you all of the information available for a symbol, as well as 
allowing you to enter high and low target prices for the symbol.

Name The company name associated with the symbol.
Price Last known price for this symbol.
$ Change Dollar change in price since previous days close.
% Change Percent change in price since previous days close.
Volume Current days trading volume.
Bid The highest price being offered for a share of this 

stock.
Ask The lowest price being asked for a share of this 

stock.
Last Update Time this data was last updated.
Open Today’s opening price for this symbol.
Open 
Interest

Used for futures contracts.

Previous Previous days closing price for this symbol.
Today’s 
High

Current day’s highest price.

Today’s Low Current day’s lowest price.
52 Week 
High

Past year’s highest price.

52 Week 
Low

Past year’s lowest price.

Low Target Price at or below which an alert will be generated.
High Target Price at or above which an alert will be generated.

You can cause PSM to generate alerts when a symbol price falls above and below a target 
price.    To do this, enter the decimal high or low target value into the edit box next to the 
appropriate label.    Pressing Apply will accept the current selection without removing the 
dialog box.    Pressing OK will accept the current selection and remove the dialog box from 
the screen.

See also
Portfolio properties



Symbol Portfolio Properties
This property page shows you your current holdings for the given symbol.    Current holdings 
are listed by date, and the current value and gain/loss is calculated.

Add
This button brings up the Purchase Details dialog box which allows you to add an entry to
your current holdings.

Remove
This button will remove the currently selected entry from the current holdings for the 
symbol.

See also
General properties



Purchase Details dialog box
This dialog box allows you to edit the details of a portfolio record.

Symbol
The ticker symbol for which the information is being displayed.

Name
The name of the company which corresponds to the ticker symbol.

Current Price
The last known price for this ticker symbol.

Purchase Date
The date the shares were purchased.    When creating new purchase records, this field is 
filled in with the current date.    If the shares were not purchased on the current date, you
may edit this field to enter the real purchase date.

Shares
Number of shares purchased.    This value may be non-integral.

Purchase Price
The actual purchase price of the shares.    When creating new purchase records, this field 
is filled in with the current price.    If the shares were purchased at a different price, you 
may enter the price here.    The price may be entered as a decimal number or as a 
fraction.

Total
The total purchase price of the shares.    This is automatically calculated when the Shares
or Purchase Price fields are changed.



General view properties dialog box

This dialog box allows you to configure the columns which will be visible in the view, and the
order in which they will appear.    To add a column to the view, click on the box next to the 
column name until a check mark appears.    To remove a column from the view, click on the 
box next to the column name until the check mark disappears.

Pressing the Apply button will change the view without removing the dialog box.    Pressing 
the OK button will change the view to reflect your selection and remove the dialog box from 
the screen.

Move Up
Clicking this button will move the currently selected column higher in the list of columns. 
It will appear before other columns in the view.

Move Down
Clicking this button will move the currently selected column lower in the list of columns.   
It will appear after other columns in the view.

Color Arrows
Checking this option will cause up arrows to be colored green and down arrows to be 
colored red.

Full-row select
Checking this option will allow you to select a symbol by clicking anywhere in the row 
instead of only on the symbol label.    It will also cause the whole row to be highlighted 
when it is selected.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Personal Stock Monitor,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Update all symbols.

Stop all network operations.

Open a new document.

Open an existing document.    Personal Stock Monitor displays the Open dialog 
box, in which you can locate and open the desired file.

Save the active document or template with its current name.    If you have not 
named the document, Personal Stock Monitor displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Display copyright and version number of application.

Select context-sensitive help.



Stop command (Toolbar)

Use this command to stop all network operations.

Note: This command also turns off Automatic Updates.

Shortcuts
Toolbar:



Status Bar

The status bar is displayed at the bottom of the Personal Stock Monitor window.    To display 
or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Context Help command

Use the Context Help command to obtain help on some portion of Personal Stock Monitor.    
When you choose the Toolbar's Context Help button, the mouse pointer will change to an 
arrow and question mark.    Then click somewhere in the Personal Stock Monitor window, 
such as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars
Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



System Menu Commands
Size command
Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Move command (CTRL+F7)
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Minimize command (ALT+F9)
Use this command to reduce the Personal Stock Monitor window to an icon.

Maximize command (CTRL+F10)
Use this command to enlarge the active window to fill the available space.

Close command (CTRL+F4 closes document, ALT+F4 closes application)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Restore command
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item 
changes to Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should 
modify a document using your application.    

If your application supports multiple document types and you want to have a distinct help 
topic for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first document type supported by your application.    AppWizard produces an alias in the .HPJ 
file for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for 
that document type. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>



Print dialog box
The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog
The Printing dialog box is shown during the time that Personal Stock Monitor is sending 
output to the printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview toolbar
The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup dialog box
The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Errors generated by Personal Stock Monitor
Unable to connect to (server name)

PSM can not determine the IP address of the requested quote server, or the quote server 
is not responding.

Unable to send request to (server name)
PSM can not complete sending a quote request because there was an error on the 
connection.

Request for symbol (symbol name) timed out
PSM has determined that data for the specified symbol has not been received during the 
allowable time period, and will close the connection for this request.

Unable to get value for symbol (symbol name)
PSM has received a response from the quote server which can not be interpreted as valid
quote data.    The response is discarded.

Can not perform operation; symbol (symbol name) is locked
An operation, such, as delete, can not complete because the symbol has been locked by 
an update operation.    You may retry the operation after the symbol is unlocked by the 
update operation.



Symbol context menu

This menu appears if you click the right mouse button in the symbol view.    The menu is said
to be sensitive to the circumstances, of where and when the mouse button was clicked, 
therefore some menu items may be disabled or not present.    The context menu is a 
convenient way to perform some symbol functions without going through the top-level 
menu.



About the Author
I have been writing one type of software or another for about 10 years.    My first computer 
was a Commodore VIC-20, and from those humble beginnings I learned to program in BASIC,
then assembly language and Pascal on an Apple //c.

By the time I graduated from college and got a real job, I knew half a dozen languages and 
operating systems, but my first post-graduation employer exposed me to Windows.    
Knowing what Unix was capable of I initially dismissed Windows as a toy.    Nevertheless, I 
got to know and like a few things about Windows, and I have come to realize that the latest 
32-bit versions of Windows are good end-user operating environments.    I also realized that I
had a little money left over after student loan payments and car payments, so I got 
interested in investing.    And from these humble beginnings PSM was born...

When I’m not writing Windows software, maintaining my employer’s Internet server (go 
Linux!),
helping people with their computer problems, or working out at the gym, I can be found 
biking, hiking, or rollerblading around the Maryland-Virginia-Washington DC area.    Or surfing
the Web.    Depends on the weather...

:-)

-Anatoly Ivasyuk
 Germantown, MD

email: aivasyuk@telogy.com
web:      http://www.telogy.com/~aivasyuk




